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Getting Started

The Carmen Sandiego Junior Detective Edition CD comes in three formats—
Window 95, Windows 3.1, and Macintosh. This booklet covers all versions,
so look below for the section that applies to you.

System Configuration: May require minor adjustments to the
configuration of your operating system and/or updates to hardware
component drivers.

Windows 5 |

System Requirements:

1 Windows 95
33MHz 386 or faster; 486 or faster recommended
8MB RAM

i 1MB hard disk space

CD-ROM drive required
Monitor/display card: SVGA 640x480, 256 colors
Windows compatible sound device




Before playing Carmen Sandiego Junior Defective Edition, you must first install a
small portion of the program (approximately 700K) onto your hard disk. This
operation makes it possible for you to establish a detective roster and keep
track of your rank and merits.

To install the game, begin at the Windows 95 desktop. [f you are not familiar
with the Wingows 95 desktop, please consult your Windows 95 manual. Insert
the disc into your CD-ROM drive (using a disc caddy if appropriate).

The Braderbund Startup-screen will automatically appear each time you insert
the disc into your CD-ROM drive. (Your system may not be able to
avtomatically display the Braderbund Startup-screen. To bring up the
Startup-screen manually, double<lick on the CD-ROM drive icon in the My
Computer group. Nofice that when the Carmen Sandiego Junior Detective
Edition disc is in the CD-ROM drive, the generic CD-ROM icon will be replaced
by Carmen Sandiego Junior Defective Edition icon.)

Click on Install in the Brederbund Startup-screen to begin the Setup program
and follow the on-screen instructions 1o install the game.

We recommend you exit other Windows programs before installation. If you
have already quit other Windows programs, then click Next to continue
installing.

The Setup program will create a default directory, C:\Program Files\Carmen
Sandiego Junior, and will then copy a number of files from the CD to this
directory. If you wish, you may specify another directory by clicking Browse.

Please take a few moments to register Carmen Sandiego Junior Detective
Edition. Registering your product qualifies you for free technical support and
nofification of future upgrades and special discounts.



To play Carmen Sandiego Junior Delective Edition:

Click Start, move the cursor to Programs, then to Broderbund Software. Click
the Carmen Sandiego Junior Detective Edition menu item to begin the game.
You may also play the game by clicking Run from the Braderbund Startup-
screen that appears each fime you insert the CD into the CD-ROM drive. If you
deaclivated the Braderbund Startup-screen, the game will automatically run
when the CD is inserted in the CD-ROM drive.

To delete a player from the Detective Roster, press Cir-D when you reach the
sign-in screen. Then click on the name you wish to delete.

Once you have launched the program and completed the sign-in sequence at
the ACME Detective Agency, you can access a menu of game opfions by
pressing CtrO on your keyboard.

Note: You can skip through most animations, during the introduction and during
the game, by pressing the Space bar.

Uninstall

After you have successfully installed Carmen Sandiego Junior Detective Edition
o your hard drive, you may remove it from your hard drive. To uninstall the
game, click Start, move the cursor fo Seftings, and then click Control Panel.
Double<lick the Add/Remove Programs icon. Select Carmen Sandiego Jr.
Edition and click the Add/Remove button. Follow the on-screen instructions to
uninstall the game. [Note: After uninstalling, the Carmen Sandiego Junior
Detective Edition icon may still appear in the Star? menu. Selecting this icon will
not launch the game, since it has Eeen uninstalled. The icon will disappear
from the Start menu the next time you restart Windows 95.]
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Deactivating and Reactivating the Startup-screen

This section applies only to users whose CD-ROM drive automafically reads the
Carmen Sandiego Junior Detective Edition CD when it is inserted and  displays
the Braderbund Startup-screen.

Each time you insert the Carmen Sandiego Junior Detective Edition disc into the
CD-ROM drive, the Braderbund Startup-screen will automatically appear-
However, after you have installed the game this window can be deactivated so
that it does not appear when the disc is inserted. When the window is
deactivated, the game will automatically run when the CD is inserted -

To deactivate the Braderbund Startup-screen:

Bring up the Braderbund Startup-screen by inserting the CD into the CD-ROM
drive. If the CD is already in the CD-ROM drive, double<lick on the < D-ROM
icon. The Braderbund Startup-screen should display. At the bottom of the
Braderbund Startup-screen is the check-box marked, "Show window next time
you insert CD." Click once on the check box, so that the check-mark

disappears. Click the Close butfon or Run button to save the setting. The next
fime you insert the CD, or double<lick on the CD-ROM drive icon, the

Brederbund Startup-screen will not appear, and the game will automatically run.

To reactivate the Brederbund Startup-screen:

Insert the Carmen Sandiego Junior Detective Edition CD into your CD-ROM
drive, and press Al-F4 to immediately quit the game. Click once with the right
mouse bution on the CD-ROM drive icon in the My Computer group. (N ote that
when the Carmen Sandiego Junior Detective Edition disc is in the CD-RCOM
drive, the game icon and title will appear as the CD-ROM icon.) Select

AutoPlay Dialog from the menu. The Brederbund Startup-screen will ap pear.
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At the bottom of the Braderbund Startup-screen is the check-box marked, “Show
window next time you insert CD.” Click once on the box, so that the check
mark appears. Click the Close button or Run button to save the setting. The
next time you insert the CD, or double<lick on the CD-ROM drive icon, the
Brederbund Startup-screen will appear.

Windows 3.1

System Requirements:

Windows 3.1

33MHz 386 or faster; 486 or faster recommended
4MB RAM (8MB recommended)

1MB hard disk space

CD-ROM drive

Monitor/display card: SVGA 640x480, 256 colors
Windows compatible sound device

Before playing Carmen Sandiego Junior Detective Edition, you must first install a
small portion of the program (approximately 700K) onto your hard disk. This
operation makes it possible for you to establish a detective roster and keep
track of your rank and merits.

To install the game, begin at the Windows Program Manager. If you are not
familiar with the Program Manager, consult your Windows manual. Insert the
compact disc into your CD-ROM drive (using a disc caddy if appropriate).

Select Run... under the File menu. In the line labeled Command Line: type:
D:SETUP or E:SETUP



([depending on whether your CD-ROM drive is located at D or E) and click on
the OK button.

The install program will create a default directory, C:\WORLDIR, and will then
copy a number of files from the CD to this directory. If you wish, you may

specify another directory during the installation process. The install program
will create a program item called Carmen Sandiego Junior Detective Edition

within a program group named Broderbund Software.

The installer will also run a MIDI sound setup program called Carmen Sandiego
Junior MIDI Setup. Follow its directions to configure the program fo make the
best use of the MIDI capabilities of your sound card. In the future, you can run
this setup program again by doublelicking on its icon in the Broderbund
Software program group.

To play the game after you have completed the installation, double<lick on the
Carmen Sandiego Junior Detective Edition icon within the Broderbund Software
program group. You may also run the game by choosing Run... from the File
menu of either the Program Manager or File Manager. In the line labeled
Command Line: type:

C:\WORLDJR\CARMEN

and click the OK button. If you installed the game to another directory or drive,
modify the path accordingly.

To delete a player from the Defective Roster, press Ctrl-D when you reach the
sign-in screen. Then click on the name you wish to delete.

Once you have lounched the program and completed the sign-in sequence at
the ACME Detective Agency, you can access a menu of game options by
pressing Cirl-O on your keyboard.



Note: You can skip through most animations, during the introduction and during
the game, by pressing the Space bar.

System Requirements:

25MHz 68030 processor or faster; Power Macintosh

System 7.0.1 or higher

5MB RAM (8MB recommended); 3.6MB free

Requires 1MB hard disk space

CD-ROM drive (2X or faster recommended)

Video: 13 inch or larger monitor, 256 colors or shades of gray

Before playing Carmen Sandiego Junior Detective Edition for the first time,
Sound Manager, Apple Multimedia Tuner, and Quicktime must be present in
your Extensions folder. If you are using a Power Macintosh, you also need
QuickTime Power Plug.

To check if you have any of these Extensions installed on your hard drive,
double<lick on the System Folder, then double<lick on the Extensions folder. If
an older version of the Extension you require is present, drag it to the Trash.
(Note: you will not be able to empty the Extensions from your trash until you
restart your computer.) Close the Extensions folder and the System Folder.

To install the required Extensions, double<click on the Multimedia Extensions
folder icon on the Carmen Sandiego Jr. Edition CD. Position the window so
that you can see iis contents and the System Folder icon at the same fime. Drag
the appropriate Extension(s) from the Multimedia Extentions window onto the
System Folder icon. This will copy the Extensions from the CD onto your hard
drive.



When prompled with a dialog message to put the Extensions into the Extensions
folder, click OK. When finished, restart your Macintosh.

Before running the game, make sure your monitor is set to display 256 colors.
To do this, select Control Panels from your Apple (&) menu, double<lick on the
Monitors icon, and select 256 colors. If you do not see 256 colors as an
option, you may need to install addifion VRAM into your Macintosh.

To play the game, double<lick on the Carmen Sandiego Junior Edition icon.

To delete a player from the Detective Roster, press Opfion-D when you reach
the sign-in screen. Then click on the name you wish to delete.

Once you have lounched the program and completed the sign-in sequence at
the ACME Delective Agency, you can access a menu of game options by
pressing Option-O on your keyboard.

If you would like to activate the menu bar at the top of the screen while playing
the game, press Option-M on your keyboard.

Note: You can skip through most animations, during the introducfion and during
the game, by pressing the Space bar.

If You Can't Get Started

IF you have followed the instructions in the previous section (“Getting Started”)
and you are still having problems loading or running the program, the following
technical advice may help. Addifional technical advice can be found in the
Troubleshooting Guide included in the box with Carmen Sandiego Junior
Detective Edition. IF the advice in either of these documents does not solve your



problem, then see the end of this section, “When All Else Fails,” to learn how to
contact the Braderbund Technical Support Department.

Window 3.1 and Windows 95

Video Display Problems

For the game to display properly, your Windows video driver must be set to
display 256 colors. The game will not function with video drivers set to
thousands or millions of colors. For instructions on changing Windows video
display drivers, please refer to your Windows manual or the manual that came
with your video board.

Screen Savers

Carmen Sandiego Junior Detective Edition usually will not have problems
running on machines using After Dark or any other screen saver. However,
should you encounter a problem, we recommend that you first disable your
screen saver before running Carmen Sandiego Junior Delective Edition. To
disable, please refer to the manual that came with your screen saver.

Not Enough Memory

Carmen Sandiego Junior Defective Edition requires that Windows has a total of
7,168K (7MB) of free memory. This amount may be a combination of physical
and virtual memory. To check the amount of free memory currently available in



Windows, begin at the Windows Program Manager. Select About Program
Manager from the Help menu. At the bottom of the information window will be
a line titled Memory which will show the amount of free memory (in K)
available in Windows.

If the total memory available to Windows is less than 7,168K try either shutting
down other applications that may be running or increasing the size of your
Windows Swap File (virtual memory). For additional information on these
procedures, please refer to your Windows manual or the Troubleshooting Guide
included in the box with this product.

No Sound

If you are unable to hear music or sound effects from the game, check to see if
you have Windows sound drivers installed. To do this, begin at the Windows
Program Manager. Double<lick on the Control Panel icon located in the Main
program group. Double<lick on the Sound icon to open the Sound Control

Panel.

If the items listed in the Events or Files dialog boxes are acfive (printed in black
text), click on the Test button. If you do not hear event sounds, make sure your
cables are fastened securely and that the volume controls for your sound device
and speakers are set high enough to be audible. If the items listed in the Events
or Files dialog boxes are grayed out, then Windows drivers for your sound
device have not been properly installed. Please refer to the manual that came
with your sound device for instructions on installing Windows sound drivers.
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Adjusting Sound Levels

IF you find there is an imbalance between the volume levels of the music and the
characters’ speech, we suggest you consult your sound system manual to make
the appropriate adjustments between the wave and synthesized sounds. [f this
doesn't work, please contact your sound card manufacturer.

Wave or Midi Sound Device Not Responding

If you encounter this error message, you may need o update your sound drivers
(wave and/or MIDI drivers) to the most recent versions provided by your sound
device manufacturer.

Turning All Sound “0ff" from the Options menu

A small number of sound cards do not allow us to control all aspects of sound
playback from within the application. If you select All Sound "Off* and you still
hear music with the photographer animations, villain animations, and/or
capture animations, you may have one of these sound cards. [f you wish to
mute the program, you may always do so by turning down the volume direcily
on your speakers or sound card.

Memory

This program requires 3,600K (3.6MB) of available memory. To check your
available memory, go to the Apple (%) menu and select About This Macintosh
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or About This Computer if you are using a Performa). Total Memory is the
amount of physical RAM installed, Largest Unused Block is the amount of

available memory.

On a Macintosh with 5MB (5,120K) total memory, you may need to free up
additional memory by disabling Extensions. For information on how to turn off
individual Extensions, please consult your Macintosh documentation or docu-
mentation accompanying the various Extensions you may have installed. (Be
sure to keep the Apple Multimedia Tuner, Sound Manager and QuickTime
Extensions active, as you will need them for the game to runl)

Sound Problems

If you are unable to hear music or sound effects from the game, check to see
that the volume control in your Sound Control Panel is set high enough to be
audible. To do this, select Control Panels from the Apple (&) menu, double
click on the Sound icon, and set the volume to a higher level.

Video Display

This program requires your Macintosh o be set to display 256 colors. To do
this, select Control Panels from the Apple menu, double-click on the Monitors
control panel and select 256 colors. [f you do not see 256 colors as an option,
you may need to install additional VRAM (video memory) into your Macintosh.

Virtual Memory
This program requires Virtual Memory to be turned off. To turn this feature off,
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select Control Panels from the Apple (&) menu, doubleclick on the Memory
control panel, and set the Virtual Memor?/ option to "OK." Close the Memory
control panel and restart your computer for this change to take effect.

32-bit addressing

This program requires your Macintosh to operate in 32:bit addressing mode.
To turn on 32-bit addressing, select Control Panels from the Apple (#) menu
and double<lick on the Memory control panel. You should see a 32-bit
addressing option (this option does not appear if your computer only operates
in 32-bit mocﬁe). Click the On button. Close the Memory control panel and
restart your computer for this change to take effect.

Conflicts with System Extensions or Control Pane| Devices

If this program appears fo be running slowly, you might want to try turning off
any unneeded Extensions that may be running. If you have any System
Extensions which may interrupt game play or use needed memory (screen
savers, for example) you may want fo turn them off before you begin play.
Please consult your Macintosh documentation or documentation accompanying
the various Extensions you may have installed for information on how to turn off
individual Extensions.

Player Roster

This program installs a file containing player infermation onto your hard drive.
This file is called ClrRoster. It will first try to install the file into the Preferences
folder inside your System Folder. If these folders are not labeled as such, the
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program will create a folder called Carmen Junior and place the ClrRoster file
inside it.

When All Else Fails

If you have followed these insiructions and still have problems, please give
Brederbund Technical Support a call at (415) 382-4747 from 6 a.m. to 4:30
p-m. Monday through Thursday, 6 a.m. to 4 p.m. Friday Pacific Time. We will
do our best to help you solve the problem. To help us solve your problem, have
the computer near the phone and already started up. Be prepared to give us a
detailed description of what happens when you try to run the program.
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Brgderbund 90 Day Satisfaction Guarantee

If you are not comihlely satisfied with your purchase, return the product lo Brederbund Software within 90 days
of the date of purchase, along with the original soles receipt and the reason for return. Please state whether you
would prefer another Brederbund product of equal or lesser value, or a full refund. Limit 1 per household.
Dealers, distributors and their employees are not eligible. Please call Brederbund Software Direct ot ;4]5) 382-
4745, or return the merchandise fo Braderbund Software, P.O. Box 6125, Novato, CA 949486123, ll}ou
wish to relurn the product via U.P.S., please send it to Braderbund Software, Attention Customer Support, 775
SouthPoint Boulevard, Petaluma, CA 94954,

The Braderbund 90 Day Satisfaction Guarantee also warrants for a period of 90 days that this copy of Carmen
Sandiego Junior Detective Edition is free from substantial errors or defects that will matericlly interfere with the
orrorionlof the program as described in the enclosed user documentation. This policy applies to the initial pur-
chaser only.

If you believe you have found ong such error or defect in the program during the 90 day period, call
Braderbund's Technical SupFon eparimen! at i415|382—47 from 6 a.m.to 4:30 p.m. Monday through
Thursday, 6 a.m. 1o 4 p.m. Friday (Pacific Time]. Broderbund Technical personnel will attempt to help you cor-
rect or avoid the problem. If any such error or defect cannot be corrected or reasonably avoided, Brederbund
will inform you how to obiain a corrected program disk Jor Crcm inform Brederbund that you prefer anather
Brederbund product of equal or lesser value, or a full refund).

RESTRICTIONS

The Software conlains copyrighted material, Irade secrets and other proprietary material. In order to protect
them, and except as ermmeg by uppliccbfe legislation, you may net decompile, reverse engineer, disassemble
or ofherwise reduce the Software fo o humun-perceivab'e form. Jou may not modify, network, rent, lease, loan,
distribule or create derivative works based upon the Software in whole or in part. You may not electronically
transmit the Software from one computer to another or over a network.

EXPORT LAW ASSURANCES

You agree and certify that neither the Software nor any other technical data received from Brederbund, nor the

direct product thereof, will be exported outside the United States except as authorized and as permitted by the

laws and regulations of the United States. If the Software has been rig lfull{obluined b Jou outside of the

United States, you agree that you will not re-export the Software nor any sther technicu( ata received from

Broderbund, nor the direct product thereof, except as permitied by the laws and regulations of the United States

ond the laws and regulations of the jurisdiction in which you obtained the Software.

GOVERNMENT END USERS

IF you are acquiring the Software on behalf of any unit or agency of the United Stales Government, the following

provisions apply. The Government agrees.

[Ci.’ if the Software are supplied to the Department of Defense (DoD), the Software are classified as “Commercial
omputer Software” and the Government is uc;uuin only “restricted rights” in the Software, and its documento-

tion as that term is defined in Clause 252.227- 0|3?:l||| of the DFARS; and

ii) if the Software are supplied to any unit or agency of the United States Government other than DoD, the

Eiovemmenr's rights in the Software, and its documentation will be as defined in Clause 52.227-19(c)(2) of the

FAR or, in the case of NASA, in Clause 18-52.227-86(d) of the NASA Supplement fo the FAR.
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DISCLAIMER OF WARRANTY
You expressly o:knowle?e and agree that use of the Software is ot your sole risk. The Software, and related
documenla'non are provided "AS 15" and without Wf1007 of any kind, If for ony reason you are du;alushed

the software return the product with your ur-gmu sales receipt to Brederbund within 90 doys of the date of

urchuse for a Rull lefund or are locemeni roduct of equal or lesser valve. Brederbund and Braderbund's

Etenml EXPRESSLY SCLMMS WARRANTIES, EX? ESS OR IMPLED, INCLUDING, BUT NOT UMITED TO,

E IMPLIED WARRANTIES RCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
BR@DEﬁBUND DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET
YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-
FREE, OR THAT DEFECTS IN THE SOFTWARE AND THE FONTS WILL BE CORRECTED. FURTHERMORE,
BRGDERBUND DOES NOT WARRANT OR MAKE REPRESENTATIONS REGARDING THE USE OR THE RESULTS
OF THE USE OF THE SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY
BR@DERBUND OR A BRDERBUND AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY OR IN
ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU
AND NOT BR@DERBUND OR A BR@DERBUND AUTHORIZED REP RESENTA“VE ASSUME THE ENTIRE COST

F ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE

EXCLUSION OF IMPLUIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

LIMITATIONS ON WARRANTY

Uncuthorized rey remnlohons Brederbund warrants only that the progl'rlam will perlorm as described in the user
documentalion. Klo other advertising, description or represenlalion, whether made by a Brederbund dedler, dis-
tributor, agent or employee, shall be binding upon Brederbund or shall change the terms of this warranty.

NO CONSEQUENTIAL DAMAGES: BR@DERBUND SHALL NOT BE UABLE FOR SPECIAL, INCIDENTAL, CONSE-
QUENTIAL OR OTHER DAMAGES, EVEN IF BR&DERBUND IS ADVISED OF OR AWARE OF THE POSSIBILITY
OF SUCH DAMAGES. THIS MEANS THAT BRZDERBUND SHALL NOT BE RESPONSIBLE OR LIABLE FOR LOST
PROFITS OR REVENUES, OR FOR DAMAGES OR COSTS INCURRED AS A RESULT OF LOSS OF TIME, DATA
OR USE OF THE SOFTWARE, OR FROM ANY OTHER CAUSE EXCEPT THE ACTUAL COST OF THE PRODUCT.
IN NO EVENT SHALL BR@DERBUND'S LIABILITY EXCEED THE PURCHASE PRICE OF THIS PRODUCT. SOME
STATES DO NOT ALLOW THE EXCLUSION OR UMITATION OF INCIDENTAL OR CONSEQUENTIAL DAM-
AGES, SO THE ABOVE LUMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

You are entfitled to use this product for your own use, but may not sell or transfer reproductions of the software or
manual fo other parties in any way, nor rent or lease the product to others without the prior written permission of
Brederbund. You may use one copy of the product on a single terminal connected to a single computer. You
moay not network the product or otherwise use it on more than one computer or computer terminal af the same
fime.

For technical support, on this or any other Broderbund product, coll 415/382-4700 065
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